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I. PURPOSE 

This document: 

• Establishes basic style and format conventions for reviews and submission 
summaries associated with a STARS submission,1 and 

• Provides general information regarding the content of reviews and submission 
summaries. 

II. FORMAT AND STYLE CONVENTIONS 

ONADE personnel are responsible for preparing their reviews or stand-alone 
submission summaries using the office templates.  When you prepare a review, stand-
alone submission summary, or a memo to file prepare only one copy for the file and 
put it on yellow paper.  In addition, these documents should adhere to the format and 
style conventions as follows: 

 
1 If the final action for a submission is File No Reply (FNR), do not prepare any review documentation 
(review or stand-alone submission summary).  If the final action is FNR w/memo, you will prepare 
appropriate review documentation. 
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A. Margins 

The document should have a 1.25 inch left margin and a 1 inch margin at the right, 
top, and bottom of the page.  Tables may extend beyond these margins for 
readability. 

B. Fonts 

• Use 12 point Times New Roman font.  The 12 point Symbol font should be 
used to insert Greek letters and special characters. 

• For statistical equations and similar situations use Microsoft Equation or the 
MathType plug-in for Microsoft Word. 

• Embed all fonts used in the document to create a clean electronic document.  
See P&P 1243.3005. 

C. Submission descriptor block 

1. The submission descriptor block on the first page should be right justified. 

2. The principal submission identification field is the first item in the submission 
descriptor block and should be in bold type.  This field identifies all principal 
submission(s) included in the review or submission summary.  Amendments, 
including End Review Amendments (ERAs), are not considered principal 
submissions and are not identified here. 

The identification of a principal submission consists of the one uppercase 
letter designation of the document type, the 6-digit document number, the one 
uppercase letter designation of the submission type, the 4-digit submission 
number and the 2-letter subclass code, separated by dashes.  Immediately 
following the subclass code, add the package ID in parentheses (e.g. N-
012345-C-0123-CP (AA) for a primary review or N-012345-C-0123-CP (A1) 
for a consulting review)2. 

 
2 A review of an ERA is technically a second review of the “principal submission as amended.”  Therefore, 
the submission descriptor block of ERA review documents should contain the principal submission 
information, not the ERA amendment (T submission) information.  Primary ERA review documents should 
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If the review applies to a group of principal submissions, include 
identification of all principal submissions in this field.  The display order of 
multiple principal submissions is determined by sequentially alphabetizing by 
document type, placing in numerical order by document number within 
document type, and, if necessary, placing in numerical order by submission 
number within a document.  For a review that addresses two principal 
submissions, list the submissions on consecutive lines using the display order.  
If the review addresses multiple principal submissions, you may find it helpful 
to display this information in a multi-row multi-column table.  This table 
should contain columns of equal width spanning the text area (6.25”).  You 
should fill the table cells using the display order in a “top to bottom” order 
within a column and “left to right” by columns. You should set the format of 
the table borders to “None”.3  You should right-justify the table cell contents.  
See Appendix 1 for examples. 

3. Place the proprietary and established names for the finished drug product 
immediately below the principal submission identifier.  When the proprietary 
and established names are both used, put the established name in parentheses.  
If a new animal drug does not have a proprietary name, use the established 
name.  If it doesn’t have either, use the identifier provided by the sponsor, e.g. 
drug class, alpha-numeric code. 

4. Include the species and class description below the proprietary or established 
name.  This is not required for manufacturing or toxicology reviews.  If the 
species or class description is exceedingly long, abbreviate this information.  
Provide a complete description of the species and class in the review. 

5. Include sponsor’s complete name.  This should be the name of the sponsor, 
not a U.S. agent or company representative.  If there is any doubt regarding 

 
include the AA package ID information.  Consulting ERA review documents should include the package ID 
of the second principal submission consult request package.  See P&Ps 1243.4070, 1243.4075, and 
1243.5730. 
3 To set the table borders to “None” in Microsoft Word, select the table (by dragging to highlight the table, 
clicking in the table and then on the “table square” near the top left of the table, or clicking in the table and 
then clicking (in succession) “Table” on the “Tools” menu, “Select” from the drop-down menu, and then 
“Table” in the secondary menu).  Once the table is selected, click “Format” on the “Tools” menu, click 
“Borders and shading” from the drop-down menu, click the “Borders” tab, click the “None” setting, and 
accept the command by clicking the “OK” button or pressing the “Return” key. 
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the appropriate name, check the name associated with the application in 
STARS (in the Overview screen) and consult with your team leader or 
division director.  Do not include the sponsor’s address in the submission 
identifier information for a review or submission summary. 

6. The date in the descriptor information should be the date the review was 
printed in final and will be considered the official date of the review for 
reference purposes.  This date may differ from the signed date found in the 
signature block. 

D. Review Title 

The title of the review should reflect the type of review written.  Format the title so 
that it is centered, bolded, and in all caps.  Optionally, you may also include the 
submission date and a secondary title beneath the main title if it adds to the clarity 
or completeness of the administrative file.  For example: 

RESIDUE CHEMISTRY REVIEW 
(Submission dated June 1, 2003) 

Assessment of the drug product formulation components 

The title of an ERA review document should reflect the type of review written, 
followed by “ - ERA”4. 

If you are writing a stand-alone submission summary for the principal submission, 
title it “SUBMISSION SUMMARY.”  Do not write a stand-alone submission 
summary for an ERA amendment. 

E. Document Header Information 

Reviews or stand-alone submission summaries exceeding one page in length 
should have a right-justified two-line header beginning 0.5 inches from the top 
paper edge.5  The header consists of the principal submission identifier, e.g., I-
012345-P-0123-MC (AA), on the first line and the review title or submission 
summary and a “Page x” entry on the second line (e.g., Residue Chemistry 

 
4 P&Ps 1243.4070, 1243.4075, and 1243.5730. 
5 Format the header by clicking on “Page Setup” from the “File” menu of Microsoft Word, selecting the 
“Layout” tab, checking the “Different first page” box, and setting the “Header” to 0.5 inches from the edge. 
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Review, Page x).  The header should be visible on the second and subsequent 
pages.  Add your package ID in parentheses immediately following the principal 
submission identifier (see Section C.2 above).  With the exception of the “ - ERA” 
review title extension for ERA review documents, the document header should not 
include information regarding amendments. 

If the review addresses two principal submissions from one administrative file or 
one submission from each of two administrative files, use two lines to identify the 
principal submissions. 

Example (Principal Submission Review):  

I-012345-P-0100-NV (AA)
I-013001-P-0004-NV (AA)

Residue Chemistry Review, Page 2 
 

Example (Principal Submission ERA Review):  

I-012345-P-0100-NV (AA)
I-013001-P-0004-NV (AA)

Residue Chemistry Review - ERA, Page 2 
 

If the review addresses three or more principal submissions, identify only the first 
submission listed in the principal submission identifier field followed by the 
phrase “et al.” to indicate the additional submissions. 

Example:  

N-012345-C-0100-CP (B1), et al.
Residue Chemistry Review, Page 2 

 
F. Signature block 

The signature block contains the author’s name and degrees held, title, review 
team or division if not affiliated with a team, mail code, and office.  Indent the 
signature block 3 inches from the left margin and leave room for your signature 
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and date above the signature block.  When printed in final, sign and date your 
review.  Your signature and date represents an acknowledgement that you assume 
responsibility as the author of the document and that the document is complete and 
accurate to the best of your knowledge and ability. 

Example: 

John Smith, M.S. 
Biologist 
Chemotherapeutics Team, HFV-143 
Office of New Animal Drug Evaluation 
 

G. cc: Block 

The cc: block begins two blank lines (or a 24 point space) below the last line of the 
signature block.  If the contents of the cc: block does not fit on the same page as 
the signature block, insert a page break and place the cc: block at the top of the 
next page.  The cc: block should list all submissions being completed with the final 
action package, including amendments.  List principal submissions on separate 
lines.  List amendments (including ERA amendments) on the same line as their 
principal submission. 

Examples of cc: block notation: 

cc: Document Control Unit, for the administrative file of: 
  I-012345-P-0123-MC, T-0125, T-0126 

 
cc: Document Control Unit, for the administrative files of: 
  I-012345-P-0123-MC, T-0125, T-0126 
  I-012346-P-0088-MC, T-0090 
  I-012346-P-0089-MC 
  I-012348-P-0007-MC, T-0008 

 

H. Other administrative information 

This area is used to record additional information such as a preparer line, notation 
of electronic copies, to document draft tracking and to record supervisory review, 



1243.3009

 
 

Responsible Office: Office Of New Animal Drug Evaluation 
Date: April 3, 2009 7
 
 

                                                

when applicable.6  The default for this field is “not applicable.”  Do not delete the 
box or heading. 

I. Appendices 

Occasionally, additional information such as emails or journal articles may need to 
be included in a review document.  Place this information at the end of the review 
document after the Other Administrative Information box in the template.  If there 
is more than one item, include each document as a separate, numbered appendix.  
If possible, this information should also be included in the same electronic file as 
the review document.  If this is not possible, include a statement in your review, 
which indicates that the appendix is included in the paper copy of the review only. 

III. PREPARING THE REVIEW DOCUMENT 

Include in your review, a summary of the submission content, your evaluation of the 
information, and your conclusions.  In addition, clearly document what letter or 
correspondence is sent to the sponsor and identify any and all enclosures.  To provide 
consistency between review divisions, use the Word template when writing your 
review.  A general description of each section is presented below. 

A. Submission Summary (section I of template) 

The submission summary is an “executive summary” of the entire submission.7  
Briefly summarize the sponsor’s requests, the administrative history of the 
submission(s), note whether you requested consulting reviews, the relevant 
conclusions of all reviews performed, and the final decision(s) to be 
communicated to the sponsor in the letter or ERA-related e-mail.  If you do not use 
a consulting reviewer’s transmit to sponsor s as written, provide a brief 

 
6 For information regarding supervisory review of CVM work products and dispute resolution, consult P&P 
1240.2110 “Procedures for Resolving Scientific/Data Disagreements Within CVM.” 
7 If you request an ERA, the submission summary of the first review document includes information only up 
to the point that the ERA is requested.  The submission summary of the second (ERA) review document 
includes information particular to the ERA, with reference to the first review document.  P&Ps 1243.4070, 
1243.4075, and 1243.5730. 
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explanation in the submission summary.8  Do not include a chronology or 
description of all previous submissions to the file or application in the submission 
summary.  An ERA review document should specifically reference the first review 
document you prepared for the principal submission. 

The submission summary is part of the AA review document.  In certain situations, 
a stand-alone submission summary will be prepared instead of an AA review or in 
addition to the summary in the AA review.  See section IV for details. 

In a consulting review, the title of this section will be “Review Summary” (see 
template).  Each consulting review will have a Review Summary Section.  In that 
section summarize only that portion of the submission you (the consulting 
reviewer) are reviewing and put it in context as it relates to the entire submission. 

B. Review (section II of template) 

Document the review of the submission.  Each division has the flexibility to 
determine the specific format for this section. 

C. Conclusions (section III of template) 

Document your conclusions with respect to the submission.  Your conclusions 
form the basis for your recommendations described in section IV of the template. 

D. Recommendations (section IV of template) 

Document your recommendation(s) for the STARS final action or non-final action 
(e.g., ERA request) with respect to the submission.  If appropriate, indicate the 
type of letter to be sent and list any enclosures that will be included with the letter, 
or indicate the type of ERA-related e-mail that will be sent to the sponsor. 

E. Transmit to Sponsor (section V of template) 

Provide, verbatim, the reviewer comments that are to be included in the letter (or 
ERA-related e-mail) to the sponsor.  Include only your comments in the Transmit 

 
8 If you need to document further discussion and concurrence with consulting reviewers, include this in the 
review section. 
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to Sponsor section and not those of other reviewers.  Also, do not include 
standardized language for the issuing letter in the Transmit to Sponsor section. 

The letter to the sponsor or ERA-related e-mail will consolidate comments from 
all reviews and incorporate any standardized language. 

IV. PREPARING A STAND-ALONE SUBMISSION SUMMARY 

A reviewer will prepare a stand-alone submission summary when: 

• No review is written. 

• There are complicated policy issues that occur after the review is 
completed but before the submission is finaled out in STARS that impact 
the transmit to sponsor/outcome. 

A supervisor will prepare a stand-alone submission summary when they override a 
reviewer’s recommendation and significantly alter the transmit to sponsor section. 

Include in the stand-alone submission summary:  1) items described in Section III. A 
(as appropriate); and 2) a description of circumstances surrounding the preparation of 
the stand-alone submission summary, such as background information, meetings and 
their outcomes, and agreements.  If the AA review has been completed, you could 
potentially have a stand-alone submission summary and a submission summary in the 
completed review. 

Do not prepare a second stand-alone submission summary specific to an ERA 
amendment.  Include ERA amendment information along with information for any 
minor amendments in the single stand-alone submission summary prepared for the 
principal submission. 

V. REFERENCES 

CVM Program Policy and Procedures Manual 

1240.2110 – Procedures for resolving scientific data disagreements within CVM 
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1243.2010 – Responsibilities for creating and keeping records 

1243.3005 – Creating clean electronic documents 

1243.3030 – Completing final action packages 

1243.4070 – Integrating an end-review amendment (ERA) into the investigational 
new animal drug protocol (E) submission review process 

1243.4075 – Integrating an end-review amendment (ERA) into the investigational 
new animal drug data (P) submission review process 

1243.5730 – Integrating an end-review amendment (ERA) into the new animal 
drug application review process 

VI. VERSION HISTORY 

September 4, 2007 – The information in this document was originally contained in 
ONADE P&P 1243.3030 (November 19, 2003 version).  This P&P updates the process 
of preparing a review and submission summary and identifies when a stand-alone 
submission summary should be prepared. 

March 6, 2008 – Revised to include information on how to create and name amended 
review documentation. 

December 4, 2008 – Section II revised to identify on what color paper reviews and 
submission summaries are printed.  Section III now includes instruction to identify in 
any review if a letter and any attachments are being sent to the outside party, state that 
the AA review prepares the submission summary, and all consulting reviews have a 
review summary. 

April 3, 2009 – Revised to include information specific to ERA processes. 
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APPENDIX 1.  FORMAT FOR MULTIPLE SUBMISSION IDENTIFIERS 

List the submission identification information in a logical way that makes it easy for 
the reader to understand to which submissions the identification information pertains. 

For example, if the same information (e.g. proprietary and established name, and 
outside party information) pertains to multiple submissions being addressed in the 
same review or stand-alone submission summary, list all of the principal submissions 
in numerical order followed by the remaining information, as shown here. 

 

I-012345-P-0161-EF (AA)
I-012346-P-0162-EF (AA)
I-012347-P-0159-EF (AA)
I-012348-P-0054-EF (AA)

Proprietary name
(established name)

Species and animal class
Sponsor's name
January 1, 2007

 

If the information is not the same for all of the principal submissions (e.g. if different 
products are involved) being addressed in the review or stand-alone submission 
summary, list the “different” information with each principal submission, followed by 
the information that is common to all of the submissions.  The example below shows 
how to present the information for applications with different proprietary names; they 
may or may not have the same established name.  If there are more than three 
submissions, use a table, as shown here. 
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N-012345-C-0119-CI (AA) 
Proprietary name 

(established name) 
 

N-012347-C-0109-CI (AA)
Proprietary name

(established name)

N-012349-C-0115-CI (AA)
Proprietary name

(established name)

N-012346-C-0109-CI (AA) 
Proprietary name 

(established name) 
 

N-012348-C-0115-CI (AA)
Proprietary name

(established name)

N-012350-C-0110-CI (AA)
Proprietary name

(established name)

 N-012351-C-0033-CI (AA)
Proprietary name

(established name)

Species and animal class 
 

Sponsor's name 
January 1, 2007 

If multiple species and/or classes are involved, it is acceptable to truncate the 
information (e.g., write “Cattle” instead of “Cattle:  Beef, Non-lactating Dairy, and 
Lactating Dairy”, or write “Multiple Species and Classes” instead of listing each 
individual species and class).  Include the detailed species information in your 
submission summary or review summary.  Species and class information is not 
required on reviews or stand-alone submission summaries for Chemistry, 
Manufacturing, and Controls submissions. 
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